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What’s New in Excel 2007 
One of the major differences between Excel 2007 and its predecessors is the new graphical user 
interface. The new user interface does not rely on multiple tool bars and menus; instead it offers a 
cleaner, more intuitive, Ribbon-based layout.  
 

The Quick Access Toolbar 
An important component of the new interface is the Quick Access Toolbar. The Quick Access Toolbar is a 
part of the user interface that you can use to store buttons or features that you rely on heavily. When 
features are added to the Quick Access Toolbar, they can be brought into play with a single click, even 
when the associated Ribbon is unavailable. 

The Default Buttons 
The Quick Access Toolbar is located in the upper left of the Excel 2007 screen, just to the right of the 
Office menu button. 
 

 
 
By default, the Quick Access Toolbar holds three buttons. These buttons are, from left to right, the Save 
button, the Undo button, and the Repeat button.  

Adding Buttons 
Excel 2007 allows you to add buttons to the Quick Access Toolbar. This can be quite useful for features 
that you use frequently. As an example, you could add the bold button from the Home Ribbon to the 
toolbar. If you did this, the bold button would always be available even if the Home Ribbon was closed.  
 
To add a button to the Quick Access Toolbar: 

� Right-click the button in question 
� Click the Add to Quick Access Toolbar option. 

 

 
 
If you wish, you can add a group of buttons to the Quick Access Toolbar at once. 
To do this: 

� Right-click on the word that defines the group (such as Font). 
� Click the Add to Quick Access Toolbar option to add the button group. 
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Below you can see that a button representing the Font group ( ) has been added to the Quick Access 
Toolbar. If you click this button, the Font button group will be displayed even though it is the Review 
Ribbon that is currently visible.  
 

 

Removing Buttons 
It is very easy to remove a button or a button group from the Quick Access Toolbar. 

� Right-click on button 
� Click the Remove from Quick Access Toolbar option.  
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Customising the Toolbar 
Excel 2007 also allows you to customise the Quick Access Toolbar by using the Excel Options screen. To 
do this, click on the small down-pointing arrow at the right of the Quick Access Toolbar. 

 
 
You will then see the following menu appear. 
 

 
 
If you click the More Commands option, the Excel Options screen will be displayed. 
 



 Microsoft Excel 2007 Intermediate 4 

 www.microsofttraining.net 2007 

 
 
On the left hand side, under Choose Commands from, select the tab that the button you wish to add to 
the toolbar is located under; or select All Commands to display the full range of commands. 
 
Select a command from the list on the left (highlighting it) and then click the Add button, the command or 
option in question will be added to the Quick Access Toolbar when you click OK. 
 
Select a command from the list on the right (the buttons that are currently on the Quick Access Toolbar) 
and then click the Remove button, the button in question will be removed from the Quick Access Toolbar 
when you click OK. 
 
Above the list of toolbar buttons on the right, you will see a drop list labeled Customise Quick Access 
Toolbar. From this drop list you can choose to have your customisations apply to all Excel documents or 
just the current workbook. 
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At the far left of the Excel Options screen you will see two arrow buttons. 
 

 
 
You can use these arrows to shift the position of buttons currently on the toolbar.  
 
If you click the Reset button near the bottom of the Excel Options screen, the Quick Access Toolbar will 
be reset to its default configuration. 
 
Finally, you can choose to display the Quick Access Toolbar at the bottom of the Ribbon instead of the 
top using the Quick Access Toolbar menu. 
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Office Button menu 
The Office button menu contains a lot of features that resided within the File menu in previous versions of 
Excel. 
 

 

 
 
 

Excel 2007 Ribbons 
The most notable feature of the new Excel 2007 interface is the Ribbon format. By default Excel has 
seven Ribbons available through tabs. These Ribbons are: 
 

� The Home Ribbon 

� The Insert Ribbon 

� The Page Layout Ribbon 

� The Formulas Ribbon 

� The Data Ribbon 

� The Review Ribbon 

� The View Ribbon 
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Where do I find?... 
Here is where you will find some of the more commonly used features of Excel. 

I want to…. Ribbon/Button Group/Command 

Add a comment Review Comments 

Add numbers using AutoSum Home 

or 

Formulas 

Editing  

 

Function Library 

Adjust the zoom View 

or 

Use Zoom slider 
(bottom right of 
screen) 

Zoom  

Apply conditional formatting Home Styles 

Change Excel’s settings Office Button Excel Options 

Create a chart Insert Charts 

Create a header or footer Insert Text 

Create a pivot table Insert Pivot Table 

Cut/copy and paste data Home Clipboard 

Filter my data Home 

or 

Data 

Editing 

 

Sort & Filter 

Format numbers in my spreadsheet Home Number 

Hide columns or rows Home Cells – Format 

Import external data into Excel Data Get External Data 

Open a file Office Button Open 

Print a file Office Button Print 

Save a file Office Button Save 

Sort my data Home 

or 

Data 

Editing 

 

Sort & Filter 

Undo/Redo Quick Access Toolbar 

Use an Excel function Formulas Function Library 

Use Page Setup features Page Layout Page Setup 

Use Print Preview Office Button Print 
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Access Keys 
Access keys give you access to the Ribbon. They relate directly to the tabs, commands, and other things 
that you see on the screen. You use access keys by pressing the ALT key followed by another key or a 
sequence of other keys. 
 
Every single command on the Ribbon, the Microsoft Office Button menu, and the Quick Access Toolbar 
has an access key, and every access key is assigned a Key Tip. 

 
 

Contextual tabs 
Certain sets of commands are only relevant when objects of a particular type are being edited. For 
example, the commands for editing a chart are not relevant until a chart appears in a spreadsheet and the 
user is focusing on modifying it. 
 
In current versions of Microsoft Office applications, these commands can be difficult to find. In Office 
Excel 2007, clicking on a chart causes a contextual tab to appear with commands used for chart editing 
(see below). Contextual tabs only appear when they are needed and make it much easier to find and use 
the commands needed for the operation at hand. 

 
 
 

Live Preview 
Live Preview is a new technology that shows the results of applying an editing or formatting change as 
the user moves the pointer over various formatting options presented on a Ribbon.  
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Themes 
The Themes button group allows you to change the colours, fonts, and other visual effects associated 
with a given Excel 2007 theme. You can find the Themes group on the Page Layout tab. 

 
 
The Themes button will display a menu of preset themes when you click it. 

 
 
Selecting any of these preset themes will apply it to your spreadsheet, affecting the colour and style of 
charts, tables, and headings. The theme in the upper left of the menu (Office) is the default theme. 
 
Each preset theme is a combination of a colour scheme, a font, and a visual style or effect. These 
individual theme components can be accessed with the other three buttons in this grouping.  
 



 Microsoft Excel 2007 Intermediate 10 

 www.microsofttraining.net 2007 

The colours and fonts buttons open menus with preset styles. 

Colours  Fonts 

 

 

 

  
The Effects button will display a menu of visual styles that can be applied to your theme. 
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Unit 1: Working with Large Worksheets 
In this unit you will learn how to: 

� Adjust the zoom on a spreadsheet 

� Use the Freeze Panes feature 

� Hide rows or columns of data 
 

Viewing and Organising Spreadsheet Data 
It is useful to be familiar with various Excel features that you can use in order to make it easier to view 
and organise data in larger spreadsheets. 

The Zoom Feature 
A single Excel 2007 spreadsheet can contain more than 1000000 rows and 16000 columns. This means 
that there can be as many as 16 billion cells in a spreadsheet. This poses a problem for viewing large 
spreadsheets. How can you possibly get a big picture of your work if it is spread over a large number of 
cells? 
 
By using Excel’s Zoom feature, you can change the viewing scale of a work sheet. By default, a workbook 
opens at 100% zoom. In the image that follows, you can see that at the current zoom level, (100%), you 
cannot see the entire block of data. 

 
 
You can use the zoom slider switch in the lower right corner of the screen to adjust the zoom. 
You can drag the slider with your mouse toward the negative (-) sign to decrease the zoom level, or 
toward the (+) sign to increase the zoom level. You can also left click on the current zoom amount (100% 
in the image above) to display preset magnification options, or to enter your own custom level of 
magnification. 

Zoom slider
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Using Freeze Panes 
It is sometimes convenient to be able to keep an eye on one part of a spreadsheet while simultaneously 
viewing other parts of the same spreadsheet (for example, keeping cells with headings in place while 
scrolling through the data). If you want to see multiple parts of your worksheet at the same time, you can 
segment your Excel 2007 screen into more than one viewing area by using Excel’s Freeze feature. 
 
To use Freeze Panes, open a workbook window, and click the Freeze Panes button on the View tab.  
Clicking this button will display a menu of freeze options that you can choose from. 
 

 
 
To freeze panes (columns and rows): 

� Select the first cell of data 

� Go to the View tab 

� In the Window group, select Freeze Panes 
 

 
 
To freeze panes (top row only): 

� Go to the View tab 

� In the Window group, select Freeze Top Row 
 
To freeze panes (first column only): 

� Go to the View tab 

� In the Window group, select Freeze First Column 
 
To unfreeze panes (any setting): 

� Go to the View tab 

� In the Window group, select Unfreeze Panes 
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Hide rows and columns 
Hiding data serves the purpose of allowing you to temporarily make column or rows from your 
spreadsheet invisible. 
 
To hide data: 

� Right-click a row or column (or a selection of multiple rows or columns) 

� Select Hide from the menu 
 

 
 
 
To unhide data: 

� Highlight rows / columns either side of the hidden one/s 

� Right-click and select Unhide from the menu 
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Using Automatic Outlining 
Excel’s grouping and outlining features will allow you to collapse a large worksheet to show or print 
summary data, and to expand the same worksheet to show or modify the details. You will find these 
features in the Outline button group on the Data Ribbon. 

 
 
Excel’s automatic outlining feature makes outlining a worksheet fairly straightforward. Automatic outlining 
works best with numerical data organised into groups and sub groups by formulas or functions. The 
following worksheet, for example, contains monthly financial data for a business, organised into quarterly 
and yearly totals using formulas and the SUM function. 
 

 
 
It can be difficult to discern quarterly and yearly totals at a glance because these figures are lost in 
amongst the other data. 
 
To automatically outline this worksheet, click the small arrow next to the Group button in the Outline 
button group on the Data Ribbon.  

 
 

This action will display a menu with two options: Group and Auto Outline. If you click the 
Auto Outline button, the spreadsheet will be outlined automatically. 
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Here you can see the results of Excel’s automatic outline. All of the original data is shown, as well as 
outline grouping indicators and collapse buttons marked with a (-). You can see that the quarters (sets of 
three months) are grouped together to be summarized by Quarterly Totals, and that each year has been 
grouped to be summarized by Yearly Totals. Notice also that the columns Supplies, Wages, and Rent 
have been grouped under Total Expenses, and that there is an overarching group of all columns under 
Profit. 
 

 
  
Here you can see the summary results of Excel’s automatic outline. The original information is still 
available in all of its detail, but it is now presented in a summary view, showing only the yearly profit 
totals. Of course, automatic outlines will differ from worksheet to worksheet depending on the way the 
data is organised.  
 
To remove the outlining from your worksheet, choose the Clear Outline option from the submenu under 
the Ungroup button. 

 

 

Displaying and Collapsing Levels 
Notice that in the preceding outline image, there are numbered buttons arranged in a row beside the 
column letters and in a column above the row numbers. Clicking on one of these numbered buttons 
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arranged in a row will expand the rows in the worksheet to provide a given level of detail. Clicking on one 
of the numbered buttons arranged in a column will expand the columns in a similar way. 
 
The view of the data in the preceding image is provided by the buttons numbered 1. Clicking on the 
number 2 button will expand the worksheet to the second level of detail for the rows, columns, or both. 
 

 
 
This is the same worksheet after both number 2 buttons have been clicked. The worksheet rows and 
column have been expanded to show another level of detail. You can now see rows with quarterly totals 
as well as yearly totals. You can also see columns with figures for Sales and total Expenses. 
 
If you click on an expand button (marked with a + sign), a specific section of the outlined worksheet 
corresponding to the button will be shown. Clicking the collapse (-) button will collapse the corresponding 
expanded section. 
 
If you click the number 3 button for the rows and columns, all levels of detail will be expanded to expose 
all of the data, as shown in the original image. 
 
Remember that with outlines, only the data that is visible on your screen will be printed. This is a great 
way to print only the pertinent information from an expansive worksheet. You can expand and collapse 
the outlined worksheet with the numbered outline buttons or with the expansion (+) and collapse (-) 
buttons to reveal the level of detail you want in your printed copy. 
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Grouping Data Manually 
Automatic outlining may not be adequate for worksheets with non numerical values or with no distinctive 
totals (from formulas or functions). 
 
If automatic outlining does not, or cannot, organise your data in the way you want, you can manually 
group your data as required. Take the following worksheet as an example. 
 

 
 
We would like to group the data according to teams and divisions, but if you use the Auto Outline option 
under the Group button, Excel displays the following alert. 
 

 
 
Because the data contains no formulas or functions providing numeric totals, Excel cannot implement 
automatic outlining for the worksheet. You can, however, create your own groupings by selecting the 
rows or columns that you want to group, and then clicking the Group button. 
 
For example, if you select the members of Team 1 (cells B4:B6) and click the Group button on the Data 
Ribbon, Excel will display the following box asking if you want to group by rows or columns. 
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If you select the Rows radio button and click OK, Excel will provide an outline indicator and a 
collapse/expand button for the new grouping.  
 

 
 
You should also notice numbered buttons in the top left corner. These outline level buttons work the same 
as before. Clicking on the number 1 button will show the first level of detail, and clicking on the 2 button 
will show the second, more detailed level. 
 
If you follow the same procedure for cells B8:B10, and then select cells B2:B10 and group them, you will 
end up with a worksheet like this. 
 

 
 
This image shown above is of the fully detailed view. If you click the 2 button, you will see the following 
view of the data. 
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You can see that the individual player information for the first two teams has been collapsed from view. 
 
Clicking the number 1 button will display the highest level view (lowest detail) of the manual groupings. 
 

 
  
In this image you can see that the entire first division grouping has been collapsed from view. 
 
You can also select rows or columns for grouping by dragging your mouse over the column letters or row 
numbers accordingly. If you select the rows or columns this way, you will not be asked whether to group 
by rows or columns, as the selection you choose will clearly indicate this to Excel. 
 
To remove manual groupings, select the rows or columns corresponding to the grouping you wish to 
remove and click the Ungroup button. 
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When you see the Ungroup dialogue box, select the appropriate radio button and click OK. The selected 
rows or columns will be ungrouped. 
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Printing Large Worksheets 
Printing spreadsheets that are larger than one page often requires adjustment of print settings in order to 
get a hard copy that paginates in an appropriate fashion. 
 

Print Titles 
The Print Titles feature allows you to select rows and/or columns which contain labels that you would like 
repeated at the top and/or left side of each printed page. 
 
To access Print Titles: 

� Select the Page Layout tab  

� Go to the Page Setup group  

� Click the Print Titles button 

� Under Print Titles, select the Rows to repeat at the top and/or Columns to repeat at left 

� Click OK 
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Page Break Preview 
Excel worksheets can get very large. In fact, most real worksheets contain too much data to fit on one 
printed page. To print a large worksheet, you have to break up the data into manageable sections. The 
point where one contiguous sheet of data is broken into separate pages is called a page break.  
 
If you print an Excel worksheet that is too big for a single page, Excel will define page breaks for you 
based on the size of the cells, the size of the paper that your pages will be printed on, and the print scale 
you choose. However, Excel doesn’t care very much about the meaning or interpretation of your data 
when it sets up page breaks. On a large worksheet, the data can be broken into pages in awkward, 
illogical ways. This is why it is a good idea to learn how to manage page breaks on your own. 
 
If you click the Page Break Preview button on the View Ribbon, you will display an Excel view that 
shows page breaks in your spreadsheet as blue dotted lines. The solid blue lines indicate the boundaries 
of the printed page. 
 

 
 

You can also access Page Break view by clicking Page Break Preview  on the status bar. 
 
The Page Break view, though not great for actually working with your data, does provide functionality. 
That is, you can still edit, copy, remove data, and choose from menus in this view.  
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This view is designed to help you organise your spreadsheets for printing. If you find that your data 
overlaps onto another page, but you would like to keep it on a single page, you can drag the blue dotted 
lines with your mouse to adjust where one page ends and another begins. 
 

 
 
If you use print preview, you can get a better idea of what this page will look like when printed, now that 
the page breaks have been adjusted. 
 

Inserting a Page Break 
To manually insert a page break: 

� Select the header of the column to the right or row below where the page break is to appear 
� Right-click on the column or row header 
� Select Insert Page Break from the menu 

 
Page breaks can also be inserted from the Page Layout tab, Page Setup group, Insert Break button. 

Printing Multiple Sheets 
Rather than selecting and printing sheets in the same file individually, multiple sheets can be printed 
simultaneously.  
 
To print all sheets in a workbook: 

� Right-click on the active sheet tab 

� Choose Select All Sheets from the menu 

� Use Ctrl + P then press Enter 



 Microsoft Excel 2007 Intermediate 25 

 www.microsofttraining.net 2007 

To print selected sheets from a workbook: 

� Click the tab for the first sheet you wish to print 

� Hold down the Ctrl key while you click the tabs for the other sheets you want to print. This will 
create a group of sheets. 

� Use Ctrl + P then press Enter 

� To ungroup sheets, right-click on the sheet tab for the first sheet you selected 

� Choose Ungroup Sheets 
 



 Microsoft Excel 2007 Intermediate 26 

 www.microsofttraining.net 2007 

Unit 1 Practice Activity 
 
1. Open Product sales.xls. 

2. Freeze all the information in column A and rows 1 through 5.  Scroll vertically and horizontally. 

3. Hide the 2003 and 2004 sales data. 

4. Unhide all the hidden columns. 

5. Create an automatic outline of the worksheet. 

6. Compare your worksheet to the example shown below. 

 
7. Experiment with all the outline symbols.  Then, show all detail. 

8. Remove the Outline. 

9. Set print titles so that the company name, subtitle, product names, year and quarter labels appear on 
every page. 

10. Adjust the page breaks by using Page Break Preview so that each year’s figures fit on one page 
each. 

11. Save the workbook as My Product sales and close. 

 
 

Online support forum and knowledge base 
www.microsofttraining.net/forum 
Visit our forum to have your questions answered by our Microsoft certified trainers. 
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Unit 2: Working with Multiple Worksheets and Workbooks 
This unit focuses on managing and analysing data on multiple sheets, both within and between 
workbooks. 
 
By the end of this unit, you will be able to: 

� Manage worksheets  
� Create 3D formulas  
� Use the Consolidate feature to create a summary spreadsheet 
� Create and manage links between Excel files  

 
 

Using Multiple Worksheets 
The default number of worksheets in a work book is three; the maximum number of worksheets is limited 
only by the memory capacity of your PC. 
 
To create a new worksheet, click the Insert Worksheet tab to the right of the existing sheet tabs in your 
workbook (or use the shortcut keys Shift + F11). 
 

 
 
 
Right-click on a sheet tab to get to the menu below. 

 

 

Insert Inserts a sheet tab to the left of the present sheet 

Delete Permanently deletes the sheet, cannot delete if there is only one sheet 

Rename To display a different name on the sheet tab 

Move or Copy Move or copy the sheet within the workbook or to a different workbook 

View Code View the VBA code in any modules in the workbook 

Protect Sheet Apply protection to the worksheet 

Tab Colour Apply colour to the sheet tab 

Hide Temporarily hide the worksheet from view (using Unhide will reverse 
this) 

Select All 
Sheets 

Creates a group which includes all worksheets in the workbook (using 
Ungroup Sheets will reverse this) 
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Navigating between sheets 
The navigation buttons to the left of the sheet tabs are used to assist with viewing sheet tabs. 

 
 
The following shortcut keys are also useful: 

Ctrl + Page Down Make the next tab to the right active 

Ctrl + Page Up Make the next tab to the left active 

 

Creating 3-D formulas 
Instead of calculating with only rows and columns on a single sheet, we can create formulas that 
reference cells on multiple sheets. 
A reference that refers to the same cell or cell range on multiple sheets is called a 3-D reference. 
 
To create a 3-D formula using a function: 

� Select the cell where the formula is to be entered  

� Type = (equal sign) 

� Type in the function name followed by an open bracketClick on the sheet tab of the first 
worksheet to be entered into the formula 

� Hold down the Shift key and click on the sheet tab for the last worksheet to be entered into the 
formula 

� On the sheet you have just selected, highlight the cell or range of cells to be included in the 
formula 

� To complete the formula, and press the Enter key 

 
 

Consolidating data 
When you consolidate worksheets, you are combining, condensing, and summarising data from multiple 
sheets into one sheet. For example, a large company may have sales or profit data broken down into 
several different geographical locations. Each worksheet would have the same layout and structure 
(template) but contain different data. With Excel, you can consolidate the different worksheets, 
summarising and totaling the data into one place to get a unified view of your information. 
 
To consolidate worksheets in Excel, open the relevant workbook and choose a destination sheet where 
the data will be consolidated. It is a good idea to set up the destination worksheet to be just like the 
worksheets that will supply the data. This means having the same labels and using the same layout and 
cell locations for the same types of data. This is not mandatory, but it can make the consolidation process 
a lot easier. If you do not have a problem with adding labels later, you can select a blank worksheet for 
your consolidation area. 
 
To consolidate sheets, you must select the cell at the upper left of the range that will contain the 
consolidated data. Then click the Consolidate button on the Data Ribbon.  
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This will display the following Consolidate Dialogue box. 
 

 
 
Under the word Function, there is a drop list containing many functions you can use to combine the data. 
In this example the default Sum is used. 
 
The text field under the word Reference is where you enter the ranges of data to be consolidated. You 
can enter the ranges manually (only recommended if you have a thorough understanding of cell 
references) or by selecting them from the different worksheets with your mouse or keyboard. (You must 
click in the Reference text field before selecting or entering ranges.) 
 
When a range is entered, click the Add button to add it to the All References field. 
This field will contain all the workbook cell references that are to be consolidated. 
 
You will notice the phrase “Use labels in” with two check boxes below it. You can check these boxes to 
consolidate sheets based on row labels or column labels. That is, the data in columns or rows that have 
the same labels will be consolidated even if the labels are under different column letters or row numbers 
in the source worksheets. For this example, the boxes are cleared and the consolidation will be based on 
the actual cell locations. This is why consolidation is easier when all the worksheets involved have the 
same labels and layout.  
 
If you fill in the “Create links to source data” check box, the information in the destination worksheet will 
be updated if the cell content in the contributing worksheets is changed.  
 
Once all options are set, make sure the worksheets and cell ranges to be consolidated are correct, and 
click OK.  
 
The worksheets will be consolidated and combined into the destination worksheet. 
 
 

Linking workbooks 
To properly manage your workbooks, you should be able to combine or consolidate data from more than 
one workbook or worksheet. By doing this, you can provide a clear and unified picture of data that may be 
spread over multiple sources. 
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Linking Workbooks 
As you know, a cell reference like K7 simply refers to the cell at the intersection of column K and row 7. A 
cell reference like Store!K7 refers to the cell at column K and row 7 in the worksheet named Store. Taking 
this one step further, the reference [Sales.xlsx]Store!K7 refers to cell K7 in worksheet Store in the 
workbook Sales.  
 
In Excel, a cell in one worksheet can contain a reference to a cell in another worksheet or in another 
workbook. This kind of linking can be useful if you have several sheets that have to reference the same 
pool of data. If you create links, the linked cells in the other worksheets or workbooks will be updated 
automatically when you update the source data. 
 

 
 
In this example above, the linked cells (indicated by arrows) are in two different workbooks. 

Using the Paste Link option 
To link two workbooks, open both of them and select the cell or range of source data that you want to use 
from one workbook.  
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Right click on the cell or range and select Copy from the menu. The copied range will be enhanced with a 
flashing black and white border. Once you have done this, right click on the cell in the destination 
workbook that will contain the linked data. (If you are linking a range of data, right click on the top left cell 
of the destination range.) Select Paste Special from the pop up menu and click on the Paste Link button 
in the lower left. 
 

 
 

The linked data will now appear in the destination workbook. If you update the source data, the linked 
data will be updated as well. 
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In this image, the cells highlighted in pink have been linked. Cell E14 in the lower workbook has been 
linked to cell B5 in the upper workbook, and the range B2:D6 in the lower workbook has been linked to 
the range D1:F5 in the upper workbook. 
 

Creating a formula to link workbooks 
There is also another way to create links between workbooks. First, click on the destination cell and type 
=. Next, click the source data cell in another workbook and press the Enter key. The two workbooks 
should now be linked, and any data or changes that appear in the source cell will be seen in the linked 
cell as well. 



 Microsoft Excel 2007 Intermediate 33 

 www.microsofttraining.net 2007 

 

Controlling link updates 
When the source workbook and the destination workbook are open on the same computer, links are 
updated automatically. When you open a destination workbook, and the source workbook is not open, 
you may be alerted by the Trust Bar (see below) whether to update the links. 

 
 
You can control whether the Trust Bar alerts you, and whether to update all links when the alert does not 
appear. You can also update only some of the links, if the workbook contains more than one link. 

Manually update all of the links or none of the links in a workbook 
Close all workbooks. If one source workbook is open, and others are closed, the updates will not be 
uniform. Open the workbook that contains the links. To update the links, on the Trust Bar, click Options, 
and then click Enable this Content.  

 

Manually update only some of the links to other workbooks 
Close all workbooks. Open the workbook that contains the links.  
On the Data tab, in the Connections group, click Edit Links.  
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In the Source list, click the linked object that you want to update.  

� To select multiple links, hold down CTRL and click each linked object. 

� To select all links, press CTRL+A. 

� Click Update Values. 
 

Dealing with Broken Links 
If the following message appears on your screen when you are attempting to update a linked file, this 
means that Excel cannot find the source file. This may be because the source file has been renamed or 
moved to a different location. 

 
 
To reestablish the link between the two files, click the Edit Links option to open the Edit Links dialogue 
box (below). 

 
 
Select the Change Source button from the Edit Links dialogue box. 

 
 
This will allow you to navigate to the source file. Once you have located the source file, select it and click 
OK. 
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You will then see that the link has been reestablished (note OK showing under Status). Any updates of 
data should have been completed. Click the Close button. 

 
 
The Edit Links dialogue box can be opened at other times by going to the Data tab, Connections group 
and clicking the Edit Links button. 
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Unit 2 Practice Activity 
 
1. Open Practice group sales.xls. 

2. Select the Total worksheet of the Practice group sales workbook. 

3. In cells B5, B6 and B7 create 3D formulas to calculate a total for each region, across all four 
quarters. 

4. Save the workbook as My group sales. 

5. Copy cell B8 from the Total sheet. 

6. Create a new workbook and select A1. 

7. Use the Paste Link option to link cell A1 to cell B8 from the Total sheet in 
My group sales.xls. 

8. Save the new work book as Mylink. 

9. Close My Group Sales.xls. 

10. View the links in Mylink.xls. 

11. Open My Group sales.xls from within Mylink.xls by using the Open source button. 

12. Close both files. 

 
 
 

Online support forum and knowledge base 
www.microsofttraining.net/forum.php 
Visit our forum to have your questions answered by our Microsoft certified trainers. 
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Unit 3: Working with dates 
This unit focuses on date formatting, date functions and simple date calculations. 
 
By the end of this unit, you will be able to: 

� Insert and format dates 
� Use dates in formulas 
� Use date functions 

 

Dates and time in Excel 
Though Microsoft Excel displays dates and times as you would expect, it stores them as numbers. 
Dates are stored as the number of days since the beginning of the last century (ie 1-Jan-1900 is day 1). 
Note that dates before 1900 are stored as text and cannot be used in calculations. 
 
Times are stored as parts of a day – i.e. 12 noon is stored as 1/2 or 0.5. Both the date and time can 
therefore be stored as a single number, the fractional part forming the time.  
 
When entering a date into a cell, Excel will accept various different formats (including year/month/day as 
well as day/month/year). 
 
Months can be entered as a number or text - the name in full or in an abbreviated (three-letter) form. 
Years abbreviated to 2 figures are taken to be between 1930 and 2029 - ie 31/12/20 is 31-Dec-2020. If 
the year is omitted, the current year is assumed. 
 
A slash or hyphen (minus sign) can be used to separate the day, month and year. Spaces can be used if 
the month appears as text. 
 
If Excel recognises data as a date it will appear on the right of the cell - if it appears on the left, Excel 
hasn't recognised it.  
 
Times are entered into a cell by using a colon to separate the hour, minute and second. They also appear 
right-justified if recognised as valid. Because the time represents the fraction of the day, the hour must 
always be included. Times can be entered with an am/pm suffix if desired (a space must precede am/pm). 
Both a date and time (separated by a space) can be entered into a cell. 
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Inserting and formatting dates 
Once a date and/or time has been entered into a cell, various format styles can be applied to the data. 
 
To apply a format: 

� Enter a date into an empty cell and press <Enter> - widen the column, if necessary  

� Press <up arrow> to move back to the cell with the date  

� Go to the Home tab, Number group 

� Launch the Format Cells dialogue box 

 

 

 

 

 

 

 

� On the Number tab set the 

Category: to Date and select the 

Type: desired  

� Press <Enter> or click on [OK] to apply the chosen format  
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Entering date functions 
There are numerous date and time functions in Excel 2007. These can be viewed by selecting the 
Formulas tab and clicking the Date & Time button from the Function Library group. 
 
Two common functions are:- 

=NOW() Gives today's date and time (eg 21/07/2005 09:30) - the two brackets are required. 

=TODAY() Gives today's date in date format (eg 21/07/2005) 

 
Other date and time functions available in Excel 2007 are: 
 

DAY  Returns the number of the day from 1 to 31. 

DAYS360  Calculates the number of days between two dates based on 360 day years. 

HOUR Gives the hour as a number from 0 to 23. 

MINUTE Gives the minute as a number from 0 to 59. 

MONTH Gives the month as a number from 1 to 12. 

SECOND Gives the second as a number from 0 to 59. 

TIME   Converts hours minutes and seconds to an Excel serial number time. 

WEEKDAY Gives the day as a number from one to seven. 

YEAR   Gives the year of a serial number date, from 1900 to 9999.  
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Using dates in formulas 
Because dates (and times) are stored as numbers, they can be used in calculations - for example, it's 
easy to work out the number of days between two dates or calculate an employee's wages given an 
hourly wage rate. Some other tasks involving times and dates are less straightforward (for example, 
sorting dates into calendar order, irrespective of the year). 
Date entries can also be used in formulae to give answers to your questions, i.e. working out a date which 
is 30 days from the present date. 
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Unit 3 Practice Activity 
 
1. Open a new blank workbook and save as Practice Dates. 

2. Type your date of birth into cell A1. 

3. In cell A2, use a function to display today's date.  

4. In cell A3, calculate how many days you have lived (a simple subtraction). 
Note: you will need to clear the cell format or change it from a date to an ordinary number.  

5. Format the result in cell A3 to read xxxxx days  

6. In cell A6, use a function and format to display the current date and time (e.g. 12/12/2007 11:32:15).  

7. Copy the result from cell A6 and use Paste Special to paste first the value and then the format into 
cell A7.  

8. In cell A8, use the data from cells A6 and A7 calculate how much time has elapsed between the 
original calculation (held in A7) and the completion of this particular task.  

9. Save the changes you have made to Practice Dates.xls and close the file. 

 
 

Online support forum and knowledge base 
www.microsofttraining.net/forum.php 
Visit our forum to have your questions answered by our Microsoft certified trainers. 
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Unit 4: Conditional formulas and formatting 
This unit considers some of the conditional formulas and formatting features to be found in Excel.  
 
By the end of this unit, you will be able to: 

� Create IF functions 
� Apply and work with conditional formatting in a spreadsheet 

 

The IF function 
Excel’s IF function can often prove to be very useful. You can use this function to branch to different 
values or actions depending on a specified condition. The structure of an If function is as follows: IF 
(logical test, value if true, value if false)  
 
IF functions are called conditional functions because the value that the function returns will depend on 
whether or not a specific condition is satisfied. As an example, consider the following function: IF (A1=10, 
5, 1)  
 
This function states that if cell A1 has a value of 10 the cell that contains the function will have the value 
of 5. But if A1 doesn’t have a value of 10, the cell that contains the function will have a value of 1. In other 
words, the function reads: if A1 equals 10 then return the number 5, else, return the number 1. 
 
Let’s say that this next IF function is entered into cell B2: IF (A1<=100, A1*.5, C3*2) 
 
This function states that if the contents of cell A1 is less than or equal to 100, the value in cell B2 will be 
the value in A1 multiplied by .5; else, the value in B2 will be the value of cell C3 multiplied by 2. 
 
You can insert an IF function by invoking the Insert Function dialogue and looking under the Logical 
category, or by typing it directly into the formula bar.  
 
The logic of the IF function can be a little confusing until you get used to it. The best way to get 
comfortable with IF functions, is to practice using them.  
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Using the Function Library 
Excel 2007 contains an extensive library of functions that you can call upon to help you solve problems. 
These tools are available in the Function Library button group, on the Formulas ribbon.  

 
 
The first and largest button is Insert Function. This button will open a dialog allowing you to search for 
and insert hundreds of functions.  
 
You can also click the small fx button next to the formula bar to display the Insert Function box. 

 
 
 
Clicking the Insert Function button activates the Insert Function dialogue box and provides access to the 
large range of functions available in Excel. 

 
 
Once the Insert Function dialogue box is open: 

� Select the function you wish to use from the available list and click OK or 
� Type the name of the function you wish to use in the Search for a function area, press Enter, 

select the function when it appears in the list and click OK. 
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Manually entering a function 
If you know which function you wish to use, you can enter a function into a worksheet by inputting it 
manually (i.e. by typing the function directly into a cell). 
 
When you do this in Excel 2007, a screen tip will appear with the possible functions that correspond with 
the letters of the function name you have entered. 
 
For example, if you type =IF into a cell the following appears. 

 
 
If there is more than one function listed, you can toggle between them by using the arrow up or arrow 
down keys. 
 
Once you have selected the function you wish to use, continue by typing in a left bracket, which will cause 
the function syntax to display in another screen tip. 

 
 
Continue to enter all the arguments required for the function to give you a result, ensuring you type a 
comma between each argument. 

 
 
Press Enter to display the result. 
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Conditional Formatting 
In Excel 2007 you can design a worksheet in such a way that data is formatted differently, based on the 
values the data assume at any given time. This is called conditional formatting.  
 
This spreadsheet is conditionally formatted to highlight cells in different colours depending on the cell 
values.  
 

 
 

Applying Conditional Formatting 
To use conditional formatting, first select a range of data that you want to apply the formatting to. 
 

 
 
The next step is to click on the Conditional Formatting button on the Home Ribbon. 
 



 Microsoft Excel 2007 Intermediate 46 

 www.microsofttraining.net 2007 

 
 
This will display a menu of conditional formatting options. From this menu, you can choose: 
 

Highlight Cells Rules This will highlight cells that are greater than, less than, between or equal to 
values that you can specify. 

Top/Bottom Rules   This option will allow you to highlight the top or bottom numbers or percent in 
the selected cells. 

Data Bars  Will display coloured bars that are indicative of the value in the cell. This is what 
is used in the image above. 

Colour Scales  Will use different shades of colour to represent different values, from low to 
high.  

Icon Sets  Will use sets of similar icons that will visually indicate a cell’s value. 

 
 
You will also notice at the bottom of the menu options for creating a new rule, for clearing rules, and for 
managing rules. 
 
Each one of the conditional formatting menu options will display either a sub menu or a dialogue box. In 
the image above, you can see the sub menu for the Data Bars option. As you let your mouse pointer 
hover over an option in the sub menu, you will see a preview of the type of conditional formatting that 
your pointer is on applied to the cells that you selected. To implement the conditional formatting, just click 
the submenu option of your choice. 
 
You can apply multiple conditional formatting rules to a group of cells by simply re-selecting the group, 
and then adding another conditional format by using the menu system discussed previously. The 
following image shows a group of cells with a data bar conditional format and an icon set conditional 
format. 
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The black and red circle icons represent low values, while the yellow and green icons represent higher 
values. You can also see that the size of the data bar in each cell corresponds to the given cell’s value. 

Creating a Conditional Formatting Rule 
If you click the new rule option near the bottom of the conditional formatting menu, you will display the 
following New Formatting Rule dialogue box. 
 

 
 
In this dialogue box you can configure more precise and specific conditional formatting rules. The options 
in the Edit the Rule Description panel will change as you clicking the different items in the Select a Rule 
Type panel.  
 
As an example, here is a rule set up for cells that contain text starting with “budget.” 
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Notice how the options in the Edit the Rule Description panel have changed. 
 
If you click the Format button, the Format Cells dialogue box will appear, allowing you to specify exactly 
what format you want for cells that meet the criteria you designed. 



 Microsoft Excel 2007 Intermediate 49 

 www.microsofttraining.net 2007 

 
 
Remember to click the OK button when you are finished specifying your format. 
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Removing Conditional Formatting 
If you want to remove conditional formatting rules, simply use the Clear Rules option from the menu. This 
option will let you clear rules for selected cells or for an entire spreadsheet. 
 

 

Using the Manage Rules Option 
The Manage Rules option will allow you to delete, edit, or add new conditional formatting rules. 
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Unit 4 Practice Activity 
 
1. Open the file Commission.xls. 

2. Select the IF function tab. 

3. Create an IF function in cell G6 which will calculate a salesperson’s commission based on their Total 
sales (column F). If the person’s Total sales are greater than 20,000 then they receive a commission 
of 5.5% of their total sales; otherwise, they receive no commission. Use the cells J4 and J5 as part of 
your formula. 

4. Copy the formula to the remainder of column G to view commission for all Sales Representatives. 

5. Select the Conditional tab. 

6. Select the range B6:E40. 

7. Apply conditional formatting to the selected range to show values in excess of or equal to £6,500 in 
Blue and values equal to or less than £5,500 in Yellow. 

8. Remove all conditional formatting from the spreadsheet. 

 

 
Online support forum and knowledge base 
www.microsofttraining.net/forum.php 
Visit our forum to have your questions answered by our Microsoft certified trainers. 
 

 



 Microsoft Excel 2007 Intermediate 52 

 www.microsofttraining.net 2007 

Unit 5: Working with Tables 
The Excel application is more than just a spreadsheet program. Believe it or not, you can actually use 
Excel 2007 as a basic database application. The key to taking advantage of these database capabilities is 
the use of lists and tables. 
 

 
 
You can define a range of data as a table and it will be highlighted with a colour scheme that 
distinguishes it from other data. The table menus and AutoFilter arrows (beside the column headings) 
help you to manage and maintain your database. You can even take advantage of user-friendly forms to 
navigate and access your tables. In short, the table and database features in Excel 2007 offer an 
alternative to complex database applications for basic database needs.  
 
In this lesson you will learn what a table is, how to create a table, how to modify a table, and how to work 
with the total row. 

What is a Table? 
In Excel 2007, a table is a specially designated range of numbers. This special range of numbers has 
added functionality that other cell ranges do not have. You can have more than one table in a workbook 
or worksheet if you want, and tables can be as large or small as the amount of data you want to work 
with. 
 
Normally a table is made from adjacent columns of data, with a unique label or heading for each column. 
Each row in the table should have entries organised according to the column headings. Remember, that 
Excel has a lot more rows down than columns across. This design is well suited for data organised in 
long, adjacent, list-like columns. You can make a table with empty rows or columns if required, but this is 
not recommended. You should keep your table data adjacent in a block to take advantage of all of Excel’s 
table features. 
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Some Excel features, like filters and PivotTables, will not work correctly if the data is not blocked together 
in adjacent columns as a table. 

Creating Tables 
To create a list from an existing range, select a range of data in adjacent columns and click on the 
Format as Table button in the Home Ribbon. 
 

 
 
This will display a menu of table formatting options. 
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If you click on one of the table menu options, the selected range will be formatted as a table based on the 
style of your choice. 
 
When you choose a table format, you will see a Format as Table dialogue box appear. 
 

 
 
If there are column headings in the first row of the range you selected for your table, check the box that 
says, “My table has headers.” Make sure the cell range shown is the range that you want for your table; if 
it is not, just type the correct range in the text field. Then, click the OK button to create your table when 
you are ready. 
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This is an example of a table created from a block of existing data. 
 

 
 
To create a table from scratch, open an empty worksheet and enter appropriate column labels for your 
data across the top row. Try to use adjacent columns so the resulting table will be as organised in the 
proper way.  
 
You can create a table at this point, based on just the column labels, by selecting the cells containing the 
labels, and then clicking the Format as Table button on the Home Ribbon. Next, select a table style from 
the drop down menu, and the Format as Table dialogue will appear. When you see the dialogue box, 
make sure that your row of labels has been selected properly, and check the, “My list has headers” box 
before clicking OK. 
 
This is an example of a list made from column headings without data.  
 

 
 
Now, you can enter data as usual into the cells of the table you created. 
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This is an example of a table with column headings and data. 
 

 

Changing the Table Range 
If you examine your table closely, you will see a small blue move handle in the bottom right corner of the 
table. If you put your mouse pointer on the move handle, it will turn into a double headed arrow. You can 
then hold down your left mouse button and drag the move handle to resize the list. You can drag 
downward to add more empty rows to the table, or you can drag to the right to add more columns to the 
table. 
 
 

 
 
If you click on a cell in your table, you will see a Design tab appear above the ribbon area of the screen. 
This Design Ribbon, should you choose to display it, contains options for working with your table. 
 

 
 
Near the bottom of the Properties button group, you will see a button called Resize Table. If you click the 
Resize Table button, the table in question will be enhanced by a dashed flashing border. You will also see 
a Resize Table dialogue appear on your screen. If you wish, you can select a new range with your 
mouse. The new range you select will be surrounded by the flashing border and will be entered into the 
range field in the Resize Table dialogue. If you resize the table by selecting a new range, be sure to 
include the row of column headings and make sure that the range of the old list is overlapped by the new 
range. If you do not do this, you will receive a warning. 
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You can enter a new range directly into the range field of the resize table dialogue, or you can select a 
range with your mouse, and it will be entered automatically. 
 

 
 
Here you can see the dashed border defining a new range that includes the original column headings and 
that overlaps the original table. When you are finished click OK and your table will be resized. 
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As you might have noticed, if you resize a table to include additional columns, Excel will insert column 
headings in the top row of the table automatically (Data4, Data52, etc.). You can modify a column 
heading by clicking on the cell with the heading you want to change and editing the heading in the 
formula bar. 
 
You can format cells in a table with the usual formatting buttons on the Home Ribbon, and you can 
change the width of the columns or the height of the rows in your table by mouse dragging the lines that 
separate the column letters or row numbers. You can also add fill colour or borders to your table if you 
want to further modify the look of your table. Pretty much anything you can do to modify a standard cell 
range, you can also do with a table. 

Inserting Table Columns 
To add a column, right click on a cell in the column next to where you want to insert a new column. From 
the menu, choose Insert, and then Table columns to the Left, or Table columns to the Right. 
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Excel will insert a column just to the left or right of the column you right clicked on depending on the 
option you choose from the menu. The new column will be labeled column1 (or column2 or column3, and 
so on, depending how many columns you insert).  
 

 
 
You will probably want to change the heading to a more meaningful field name than Column1. To do this, 
just click the cell that contains the new column heading and edit it in the formula bar. 
 
You can also quickly add additional columns to your table by clicking a cell to the immediate right of the 
table and then entering data into the cell. 
 

 
 
Here is the same table after making cell E1 the active cell, typing Mark Up into the cell, and pressing the 
Enter key.  
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Inserting Table Rows 
You can insert rows in a table by right clicking on a cell in the row below where you want to insert. 
Choose Insert from the menu, and then choose Table Rows Above from the submenu. 

 

 
 
The new row will be inserted just above the row you right clicked on. This means that if you right click on 
the top row of the table, the Table Rows Above option will not be available, as the top row contains the 
column headers, and any row above this will not be included in the table.  
 

 

Quickly Adding Rows to a Data Table 
You can quickly add a new row to the end of a table by clicking on a cell immediately below the table and 
entering data into it. The new row will automatically be included in the table range, provided the new data 
is not entered underneath a Total Row.) 
 
When you press the Enter key after typing your data into the cell, a new row will be added to the bottom 
of the table. 
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Deleting Rows or Columns 
To delete a row from your table, just right click on a cell in the row that you want to remove. 
 

 
 
When you see the pop up menu, select Delete, and then choose the Table Rows option. This will remove 
the entire row containing the cell that you right clicked on. 
 
To delete a column from a table, just right click on a cell in the column that you want to remove, and then 
choose Delete, followed by Table Columns, from the menus. This will remove the column from the table. 
 

Creating a Table Total Row 
If you are working with a table in Excel 2007 and you click on a table cell, a tab called Design should 
appear. 
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If you display the Design Ribbon, you should see a check box in the Table Style Options button group 
labeled Total Row.  
 

 
 
Clicking on this checkbox will display another row at the bottom of the table, with the word Total in the first 
cell. You can also display this Totals Row by right clicking a cell in the table and choosing the Totals Row 
option from the Table sub menu. 
 

 
 
If you click on a cell in the Totals Row, you will see an arrow appear indicating a drop list. 
 

 
 
If you display the drop list from a cell in the total row you will see a number of options. 
 

None Will show nothing in the total row for this column 

Average Will show the average of numerical values for the column 

Count  Will show the number of items in the column 

Count Numbers Will show the number of values in the column 

Max  Will display the maximum item for the column 
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Min  Will display the minimum item for the column 

Sum  Will display the sum of numerical data in the column 

StdDev  Will show the standard deviation for numerical column data 

Var  Will show the variance of numerical data in the column 

  
You can select each cell in the Total Row in turn and choose an option from the drop list to apply to the 
particular column of data. 
 
In the following example, the Total Row shows the maximum (most recent) invoice date, the average 
invoice total, a count of the invoice numbers, and nothing. 
 

 
 
If you drag the move handle to lengthen the table, the Total Row will stay at the bottom. If you enter any 
new data into the table the values in the Total Row cells will be recalculated accordingly. If you want to 
change what is displayed in the Total Row, you can click on any cell in the row and choose another option 
from the drop list to design the Total Row as you see fit. You can hide the Total Row by clearing the Total 
Row checkbox on the Design Ribbon, or by right clicking a cell in the table and choosing Totals Row from 
the Tables sub menu. 
 
 

Sorting and Filtering Tables 
Excel tables are intended to help users manage, maintain, find, and retrieve data. In this lesson, we will 
explore some of the tools Excel 2007 provides for managing and retrieving information from a table. You 
will learn how to sort a table, and how to work with AutoFilters, custom AutoFilters, and advanced filters. 
You will also learn how to copy filtered records. 
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Sorting Data in a Table 
To sort a table, choose a field that you want to sort by, and click on the AutoFilter arrow at the top of the 
column. (If you cannot see the AutoFilter arrows just click on a column heading in your table and then 
click the Filter button in the Data Ribbon.) Clicking on the arrow will display a drop list of options for 
filtering your records. 
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The drop list that you see is an AutoFilter list. Any option you choose from the list will result in all table 
rows being reorganised, according to the column you sort by. In this image, the AutoFilter drop list for the 
invoice total field is shown. You can see some sorting options (Sort Smallest to Largest, Sort Largest to 
Smallest) at the top of the menu, and lower, a list of values for this field from each record. 
 
The first two options on the list are sort options. The first sort option (smallest to largest) will sort the 
records in your table from smallest to largest based on the current field. The second sort option will do the 
opposite thing: sort from largest to smallest. 
 
Here is a simple table, sorted from smallest to largest based on the Invoice total field.  
 

 
 
 
Here is the same table, this time sorted Newest to Oldest by the Invoice date field. 

 
 
You can also sort your table by clicking on a cell in the table and then clicking the Sort button on the Data 
Ribbon.  

 
 
This will display the Sort dialogue. 
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With the Sort dialogue box, you can select a column to sort from the drop list and then choose a quality of 
the given field to sort on (i.e. value, cell colour, or font colour). You can then choose the order of the sort. 
 
After you create a rule to sort by, you can click the Add Level button and create a Then By sorting rule. If 
you create this type of rule, if there are values in a column that are the same for the first sorting field (two 
people named Bob for instance) the order for these two records will be decided by the Then By sorting 
field. You can even specify a third sorting field for the unlikely event that there are equal values in the first 
two.  
 
 
 
When you finish configuring the Sort by dialogue box, click OK, and the sorting scheme will be 
implemented on all of records in your table. 
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What is an AutoFilter? 
An AutoFilter is an Excel feature that lets you filter out rows from a data table. You can select an 
AutoFilter option and only rows that meet the specified criteria will be shown. 
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Look at the following table carefully. 
 

 
 
You will see that there are some duplicate values for some fields (for example, there are three people 
named Bert). 
 
If we wanted to only show the rows for people named Bert, we could filter out the rest by clicking the 
AutoFilter arrow next to the Name column heading. If you don’t have AutoFilter arrows in your table, click 
on the column heading of your choice or click on a cell in the table, and then click the Filter button on the 
Data Ribbon. Clicking this button will hide the AutoFilter drop lists if they are currently visible.  
 
When you display the AutoFilter drop list, you will see the corresponding column values from your data 
table in ascending order. The records for list items without a checkmark will be filtered out, and the 
records for list items with a checkmark will be shown. 
 

 
 
Notice that each unique column entry is present in the list. If you have a lot of rows in your table, the 
AutoFilter list will scroll to show you all of the columns in question. For this example, if we select the entry 
Bert for our filter (meaning only Bert’s name will have a check next to it) only the rows containing Bert in 
the Name column will be shown. 
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If you put a mark in the checkbox next to the Select All option from the AutoFilter drop list, no filtering will 
be applied and all of the rows will be shown (because there will be a check next to every list item). 
 

 
 
In this example, the rows containing the names Bert and Cindy will be shown, while the rows with the 
names Bob, John, Kevin, Sandy, and Vera will be filtered out.  
 
If you display the AutoFilter menu for a column of names, or other text entries, you will see an option 
called Text Filters. If you display the AutoFilter menu for a column of numbers, you will see a Number 
Filters option instead. If you click on the Text Filters option or the Number Filters option, you will see a 
sub menu of further filtering options. If you click one of these options, you will display the custom 
AutoFilter dialogue box. 
 

Custom AutoFilters 
With the custom AutoFilter options, you will be able to set up a customised filter for your data table. 
 
To create a custom AutoFilter, select a field heading that you want to filter with and choose Custom Filter 
from the AutoFilter drop menus. 
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This will open the Custom AutoFilter dialogue box. 
 

 
 
In this dialogue, you can use the drop down arrows and radio buttons to set up filtering criteria for your 
records. (You can see that this Custom filter will be based on the Name field, because the word Name is 
displayed in blue at the upper left of the dialogue box.) 
 
The first drop list, with the default value Equals, will display the following expressions that you can choose 
from to create a filter. 

� Equals 

� Does not equal 

� Is greater than 

� Is greater than or equal to 

� Is less than 

� Is less than or equal to 

� Begins with 

� Does not begin with 

� Ends with 
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� Does not end with 

� Contains 

� Does not contain 
 
The next drop list (on the immediate right) will contain values from your data table belonging to the 
current field. 
 

 
 

 You can select the And radio button or the Or radio button to incorporate additional criteria into your filter. 
The two drop lists here are the same as the first two.  
 
When you use the And/Or radio buttons to build custom filters, remember:  

� For the And option, both conditions (A and B) must be satisfied for the record to be shown. 

� With the Or option, records that satisfy either condition will be shown. 
 
 
You can use the radio buttons to combine filtering conditions, or just filter base on options from the first 
two drop lists. To understand how to create a custom filter with these option lists, look at the following 
example. 
 

 
 
Selections have been made in this custom filter box that essentially state that the value for Height must 
be less than 70 and greater than 63 for a record to be shown. In other words, this filter will remove all 
records with a height greater than or equal to 70 and height less than or equal to 63. 
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Here are the records that this filter selected. You can tell which field has a filter applied to it by the funnel 
icon that appears on the AutoFilter drop list button.  

 

Removing Filters 
To remove any filters that have been applied, select a cell within the table range. On the Data tab, Sort & 
Filter group, click the Clear button. All table data is then restored. 
 

Filtering with Wildcard Characters 
Sometimes when you are using a custom filter, or even an advanced filter, it can be difficult to get 
precisely the kind of records you want. By using wildcard characters you can fine tune your filters to 
retrieve all the data that you are after.  
 
In Excel, you can use the question mark (?) or the asterisk (*) as wildcard characters. A question mark will 
substitute a single character in a string, while an asterisk can substitute multiple characters in a string. For 
example, the string “ca?” could be car, cat, can, cap, and so on. The string “tele*” could be television, 
teleportation, telemarketing, and so on.  
 
To see how to use these wild card characters in a filter, take a look at the following Excel data table. 

 
 
If you wanted a list of records pertaining to bears, you could use a wild card character in your custom filter 
in the following way. Remember, you can display the custom filter box by selecting the Custom Filter 
command from the AutoFilter drop menus in the Animal column. 
 
To filter our records for bears, we would select equals and type “* Bear” as filtering criteria.  
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This is the resulting list for the custom AutoFilter. It contains every record from the table with the word 
Bear in the Animal field.  

 
 
Here is another table and custom AutoFilter using the ? wild card and the * wild card. 
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The first condition tests if Animal equals L?on. The first condition is combined with a logical or to the 
second condition, which tests if Animal equals D*. The Or condition will return the records that meet either 
criterion.  
 
The records that have a word starting with the letter D and the records that have a four letter word of the 
form L?on (where ? can be any letter) will be shown. (These criteria are based on the Animal field.) 
 
Here are the results of the wild card filter. 
 

 
 
It should be noted that the wild cards do not have to appear at the beginning or end of a word. They can 
be used anywhere in a word to substitute the characters you want. For example, 
“ma*atics” could represent the word “mathematics” with the * substituting for the letters t, h, e, and m. 
Similarly, “Ro?e” could represent Rope or Role or Rose or any other word of this form.  
 
When using wildcard characters you should be clear on the distinction between the asterisk and the 
question mark. “H??se” is not the same as “H*se,” because “H??se” could be Horse or House but not 
Hose, while “H*se” could be Horse, House, or Hose.  
 
You can combine both wildcard characters into one term (as in “S*e?), but the resulting records may be 
surprising because of the generality of the wild cards. (The example wild card term S*e? could be Sewer, 
Softer, Soften, or Salamander, to mention only a few of the possibilities). 
 
The best way to find out what you can do with wild card characters is to experiment with them. 
 

Using an Advanced Filter 
If you can’t get the results you want from a custom filter, you can construct your own advanced filters to 
get the most control over your data tables. 
 
To make an advanced filter, you have to set up a range of criteria to filter your table with. 
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In this example, we want to show only the records where the Age field is less than 40. To do this, you can 
type a column heading in cell F1. This heading must be exactly the same as the corresponding heading in 
the data table that you want to base the filter on. 
 
In cell F2, you can enter the criteria. In this instance, cell F2 contains <40 as you only want to show 
records with an age field value that is less than 40. To apply the filter, click on any cell in the data table 
and then click the Advanced button on the Data Ribbon. 
 

 
 

You will now see the data table outlined with a flashing dashed border, and the Advanced Filter dialogue 
box will be displayed. 

 
 
When you see the box, make sure the table range is indeed the range you want to filter. You can then 
click in the data area labeled Criteria Range and select the cells that contain your filtering criteria (cells 
F1:F2 in this case). 
 
The Filter the List in-Place radio button is selected, so the filtered records will appear in the same location 
as the original table. Click OK to filter the List range using the Criteria range as specified in the Advanced 
Filter dialogue. 
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The table has been filtered to show only those records that have an age field value that is less than 40. 
 
To display the full table again, click the Clear button in the sort and filter button group on the Data Ribbon. 

 
 
You can set up more complex filters by adding to your criteria range. For example, the following criteria 
range will filter the records so that only those with an age less than 40, a height greater than 63, and a 
weight less than 180 will be shown. Notice that the column headings in the criteria range are identical to 
those in the original table. 

 
 
This next criteria range will show records that have a height greater than 63 or a weight less than 180. 
The conditions are offset by one row from each other, indicating the use of a logical Or operator. 
 

 
 

Copying Filtered Records 
It may be the case that you want to extract your filtered records to a new place in the worksheet or even 
to a new worksheet altogether. Copying your filtered records to a new location leaves the view of your 
original data table unchanged. 
 
To copy your filtered records to a new location, set up a criteria range as before, with column headings 
and the conditions you want to specify. In addition, you can prepare a range for the filtered records to be 
copied to. To do this, you can choose some empty columns and label them with the headings for the 
fields you want to display. You do not have to display an entire record, just the fields of your choice. 
 
Make sure the column headings for the range you are copying to are exactly the same as the column 
headings in the original unfiltered table. If you do not put column headings in the copy to range, all of the 
fields specified in the table range will be copied. If you are copying entire records, you can leave the 
range you are copying to blank. 
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Click a cell in the data table, and click the Advanced button in the Sort and Filter group on the Data 
Ribbon to display the Advanced Filter box. Set your options as before, but this time, choose Copy to 
Another Location from the radio options at the top. 
 

 
 
Select the range that you that you have prepared for the copied records with your mouse or type it in 
directly. If you don’t know how large a range to select, select the column letters above the fields you have 
chosen in the destination range. If you are copying all fields (i.e. complete records), just click on a cell in 
the upper left of the range you are copying to. Click OK to copy the filtered records to the destination 
range. 
 
The image that follows shows the fields Weight and Age filtered from the main table and copied to 
columns I and J, according to the condition that height is less than 70 .Because the column headings 
Weight and Age have been specified in the destination range, only the weight and age of people with a 
height less than 70 will be shown in the destination area. 
 

 
 
You can also specify unique records only by clicking the appropriate checkbox in the Advanced Filter 
dialogue box. This will ensure that duplicate records are not selected or copied.  
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Creating Subtotals 
Another kind of outlining or grouping technique available in Excel is the subtotals feature. If you have 
numeric data organised with clear column and row headings, you can use Excel to create automatic 
subtotals and grand totals for the data.  
 
The following worksheet contains sales information for different products across geographical regions. 

 
 
To use Excel’s subtotal feature, select the range of data you want to apply subtotals to and click the 
Subtotal button on the Data Ribbon. Be sure to include the column labels in your selection so Excel will 
be able to discern what numbers to total. For this example, you could select A1:E10 and click the Subtotal 
button on the Data Ribbon to invoke the following Subtotal dialogue. 

 
 

 
The drop list under the “At each change in” heading gives you options as to the number of rows that will 
be totaled. (Totals will be applied every time the values under the chosen column label changes.) 
 
The “Use function” drop list lets you choose from a list of functions including SUM, AVERAGE, COUNT, 
PRODUCT, and STDEV to apply to your data. The function you choose (normally SUM) will be used to 
calculate the totals. 
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Under the “Add subtotals to” option list, you can select which columns to apply the totals to. You can 
apply totals to a single column or to multiple columns in the selected range. 
 
Finally, there are three check boxes at the bottom of the dialogue box that will allow you to:  
 

� Replace any pre existing subtotals 

� Put page breaks between totaled groups so they will be printed on separate pages 

� Place the subtotals and grand totals above or below the corresponding data 
 
If you choose to apply totals to each change in the region column while using the Sum function for the 
profit column, and with no page breaks, the resulting worksheet will look like this. 
 

 
 
Notice that there is a subtotal for the profit figures at every change in the region value. There is also a 
grand total for the Profit column at the end of the data. You can also that Excel has provided outlined 
levels, collapse/expand buttons, and numbered outline level buttons associated with the totals. These 
buttons and outlines work exactly as previously explained. The lower the number on the button, the less 
detailed information will be shown. 
 
To remove these subtotals, select the range of data in question (A1:E14) and click the Subtotal button to 
invoke the subtotal dialogue box. When you see the box, click the Remove All button. 
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Unit 5 Practice Activity 
 
1. Open Practice Employee.xls. 

2. Create a table that includes all column headings and associated data. 

3. Sort by Last Name in ascending order. 

4. Sort first by City in descending order, then by Name in ascending order. 

5. Use the AutoFilter to display only those records for the residents of San Diego.  Then, display all 
records again. 

6. Display only those records for San Diego or Riverdale. Then, display all records again. 

7. Create a filtered list to display only those records where the salary level is greater than 12000 and 
less than 23500. 

8. Turn off AutoFilter. 

9. Save the workbook as My Practice Employee and close. 

 
 

Online support forum and knowledge base 
www.microsofttraining.net/forum.php 
Visit our forum to have your questions answered by our Microsoft certified trainers. 
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Unit 6: Documenting and Auditing 
This unit introduces the use of comments and looks at using the Formula Auditing group to trace errors in 
formulas. Worksheet protection will also be covered. 
 
By the end of this unit, you will be able to: 

� Work with comments in a spreadsheet 
� Trace errors in a formula  
� Apply protection to all or part of a worksheet  

 

Comments 
There may be times when certain data elements or formulas in your spreadsheet need some explanation. 
Annotating a spreadsheet is a good idea if you intend on sharing it with other users. Your notes will help 
the people you share your spreadsheet with understand what is going on. The Comments button group 
allows you to add comments and explanations to your spreadsheet as you see fit. 
 

 
 

Adding, editing and deleting comments 
The New Comment button can be used to add a comment to your spreadsheet. 
You can delete a selected comment with the Delete button, or move between comments with the 
Previous and Next buttons. 
 
The Show/Hide Comment button will show or hide the comment associated with the currently selected 
cell. The Show All Comments button will show all of the comments that have been added to the 
spreadsheet. The Show Ink button will show only those comments that have been added via an ink 
device (such as a handwriting tool). 
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The Formula Auditing Group 
Excel 2007 provides some great features for working with formulas in the formula auditing button group. 
To display these buttons, click the Formulas tab to show the Formulas Ribbon. This group of formula 
auditing buttons can help you trace errors and show the cells that are referenced in a formula. 
 

 
 
If you let your mouse pointer hover over each button in the button group, you will see a brief description of 
the button’s function. 
 
The Trace Precedents button will display blue arrows to cells that supply data to the formula (arrows may 
be red if a supplying cell has an error). 
 

 
 
 
The Trace Dependents button will display arrows to the other cells that depend on a given cell’s data.  

 
 
The Remove Arrows button will remove both precedence and dependence arrows from your Excel 
screen. 
 
The Show Formulas button will toggle between showing results and formulas in the worksheet. 
 
The Error Checking option will check the entire worksheet for formula errors. If any are found, you will be 
alerted with an error checking dialogue (like the one below) that pertains to the specific error in question. 
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You can also click the down arrow next to the Error Checking button to see additional options. 
 

 
 
The first option (Error Checking) will perform the same action as if you clicked the Error Checking button 
directly. The Trace Error option will display arrows to the cells referenced in an incorrect formula. The 
Circular References menu will display cells that contain circular references, if there are any in the 
worksheet. 
 
The Evaluate Formula dialog will help you analyse, interpret, and correct formulas. 
 

 
 
Last but not least, the Watch Window button will display the watch window dialogue (shown below). 
 



 Microsoft Excel 2007 Intermediate 84 

 www.microsofttraining.net 2007 

 
 
You can use this dialogue to watch a cell or selection of cells (perhaps from another worksheet) while you 
make changes to the data in another area.  
 
If you find that your formula just isn’t producing the correct results, try the formula auditing buttons. These 
features can help you fix formula mistakes by checking your worksheet for errors and tracing cell 
dependencies so you can see all of the cells that are referenced in a formula. 

Fixing Formula Errors 
Formulas in Excel can range from the simple to the complex. When entering formulas, there are a number 
of mistakes that you can make, like leaving out a parenthesis or referencing the wrong cells. If you have a 
long formula with several cell references and it just doesn’t seem to work, pinpointing the error can be 
tricky.  
 
A good first step in fixing formulas is learning to understand Excel’s error messages. When you see a 
number sign (#) followed by some text, rather than the expected result, your formula contains some kind 
of error. 
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#NAME? Means that you entered something in your formula that Excel interprets as an incorrect 
cell reference, range, or function name. 

#REF!  Indicates that you might have relocated or deleted a cell that is referenced in the formula. 

#VALUE!  Tells you that you are probably using text in a formula when another argument (probably a 
number) is required. 

#DIV/0!  Occurs when you divide a number by zero or divide by a reference to an empty cell. 
Remember, division by zero is mathematically undefined. 

#NUM!  Can occur when you try to pass an incorrect argument, like text, to a function that is 
expecting a numerical value. 

#######  Means that a number is too wide to be displayed in the cell. Double-click the column 
separator to resolve this error. 

 
When you see an error message, make sure that the cell with the message is the active cell, and carefully 
examine the cell contents in the formula bar. 
  
If you cannot find the error based on Excel’s error message, try to trace the precedent cells or dependent 
cells of the formula in question by using the formula auditing buttons. When you locate these cells, 
examine them for typing mistakes or incorrect cell references. Use the kind of error message you are 
getting as a clue for what you are looking for (i.e. division by zero or text being used in an equation). 
 
Try to examine the contents of every cell involved in the formula to make sure that the data types 
(number, text) are appropriate. Remember, you can still have an error in your formula even if you do not 
get an error message. The formula may produce a numerical result as expected, but the result is 
incorrect. If this happens, examine the mathematics of your formula. Did you place the parentheses in the 
right places? Are you using the right functions? Are you using the right mathematical operators?  
 
Finally, try to avoid errors by planning out long and complex formulas before you enter them.  
 
 

Protection 
The information in your Excel workbooks can be very important. One possibility is that your workbooks 
contain sensitive and confidential data that should only be seen by authorised users. Another possibility is 
that your workbooks contain crucial data that must not be modified or altered in any way, intentionally or 
otherwise. Perhaps your information is such that you must keep it private, and secure.  
 
Fortunately, Excel 2007 provides mechanisms for protecting and securing your workbooks. In this lesson, 
you will learn how to protect the structure of your workbook and you will learn how to protect your 
workbook from unauthorised users. In addition, you will learn how to protect the data in your workbook on 
a sheet by sheet basis. 
 

Protecting your Worksheets  
Excel 2007 allows you to protect your data on a worksheet by worksheet basis. This feature is useful for 
situations where users are permitted or required to modify data on one worksheet, but are forbidden to 
modify data in another worksheet in the same workbook. To protect a worksheet, you must click the 
Protect Sheet button. 
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When you click this button, you will see the following dialogue box. 
 

 
In the dialogue box, you will notice a series of checkboxes. If you place a check mark in a checkbox and 
then protect the sheet, a person using the spreadsheet will be able to perform the task that you checked. 
In other words, users will be able to perform any tasks that you select with checkmarks, and they will not 
be able to perform any tasks that are not checked.  
 
You will notice a checkbox at the top of the dialogue that reads “Protect worksheet and contents of locked 
cells.” If you put a check in this box, any locked cells on the sheet will be protected. The contents of a 
locked and protected cell cannot be edited or changed without the password. By default, all of the cells in 
your worksheet are locked, so when you protect the sheet, the data in the cells cannot be modified. The 
important concept here is that protecting your sheet with the Protect Sheet dialogue will prevent users 
from editing the contents of any locked cells. Since all of the cells in a worksheet are locked by default, 
applying worksheet protection will prevent the cells from being modified.  
 
The topic of unlocking cells will be addressed immediately after this discussion of worksheet protection. 
 
After you set up the tasks that you will allow users to perform, you can enter a password in the Protect 
Sheet dialogue and click OK. If you click OK without entering a password, the sheet will be protected, but 
you will not require a password to unprotect it (meaning any user can unprotect the sheet if it has no 
password).  
 
When you enter a password and click OK, Excel will ask you to re-enter the password to confirm it. 
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If you re-enter the password correctly and then click the OK button, the worksheet will be protected. To 
unprotect the worksheet, you must click the Unprotect Sheet button on the Review Ribbon, and then 
enter the correct password to unprotect the sheet. 
 

 
 
When you set up worksheet protection, it will be applied to the currently active sheet. To apply protection 
to multiple sheets, you must select each sheet (click on the sheet tab at the bottom of the screen) and 
apply protection to it individually. In this way, you can configure different protection options for each 
different sheet in your workbook. If you wish, you can use a different password to protect each sheet in 
your workbook (though it is probably a better idea to avoid confusion and use the same password for 
each sheet). 

Unlocking Cells 
If you want to prevent users from modifying the actual cell data in your worksheets, your cells must be 
locked and the worksheet must be protected. In Excel the cells are locked by default, so when you protect 
a worksheet, the cell data can no longer be modified. If you try to modify a locked cell in a protected 
worksheet, you will see the following warning. 
 

 
 
But suppose that you want users to be able to modify the data in some cells. To accomplish this, you 
must unlock the cells that you want to be editable before you protect the worksheet.  
 
To unlock cells in a worksheet, first select the cells that you want to unlock, and then invoke the Format 
Cells dialogue. You can do this by clicking the small arrow at the lower right of the Font button group on 
the Home Ribbon. 
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When you see the Format Cells dialogue appear, click the Protection tab. 

 
 
If you clear the checkmark from the checkbox labeled Locked, the cells you selected will now be 
unlocked. When you protect the worksheet with the Protect Sheet button on the Review Ribbon, the 
locked cells will not be editable, but the cells that you selected and unlocked will be editable. This means 
that users can modify the cells that you unlocked, but they can do nothing to the data in the other cells in 
the sheet. 
 
You can also password protect ranges in a locked spreadsheet. This will allow users with a password to 
unlock specific ranges of cells. To add this security feature to a spreadsheet, click the Allow Users To Edit 
Ranges button on the Review Ribbon. 
 

 
 
When you click this button, you will see the following dialogue box. 
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If you click the New button in the upper right of the dialogue, you will see the following New Range 
dialogue. 
 

 
 
Your next step is to enter a title for the password protected range in the Title field. After this, enter the 
cells themselves by putting the focus (cursor) in the Refers To cells field, and then selecting the cell range 
in question with your mouse. When the selected range is entered into the field, place your cursor in the 
Range Password box and enter the password for the range. When you click the OK button, you will be 
asked to repeat the password to ensure that it is correct. 
 
When you do this correctly, you will be returned to the Allow Users To Edit Ranges dialogue. 
 

 
 
This time, you will see the range that you protected and its title in the viewing area of the dialogue.  
 
If you want to modify the title, the password, or what cells are included in the range, you can click the 
Modify button. 
 
If you want to delete the range, click the password protection for the range and click the delete button. 
 
Finally, when you click the OK button the range will be password protected. This means that when you 
protect the locked cells in this worksheet, users who know the password for the range can unlock the 
cells in the range with the password. 
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You must enter the password to be able to edit the cells in the range, but, when you enter the password, 
only the range you set up for this protection will be unlocked. The rest of the spreadsheet cells will still be 
locked, even to the users that know the range password.  
 
Remember, the entire sheet must be protected for the range password to be useful. Otherwise, the cells 
will already be unlocked.  
 
If you want to be serious about preventing users from editing locked cells, you should always use a 
password when you apply protection to a worksheet. 
 

Protecting your Workbook  
There are two basic forms of protection that you can apply to your Excel 2007 workbook. First, you can 
protect the structure of your workbook, and second, you can protect the windows in your workbook. If you 
protect the structure of your workbook, users will not be able to add, delete, or move any of the 
worksheets in your workbook. The arrangement of the worksheets will be fixed as long as the structure is 
protected. If you protect your workbook windows, the sizes and positions of any windows in your 
workbook will be preserved so that every time you open the workbook, the window layout will be the 
same.  
 
To apply these types of protection to your workbook, click the Protect Workbook button on the Review 
Ribbon and choose the type of protection that you want. 
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If you click Protect Structure and Windows, you will see the related dialogue. 
 

 
 
If you put a check mark in the Structure check box and click the OK button, the workbook structure will be 
protected. This means that users will not be able to remove, add, or change the order of worksheets in 
the workbook. If you put a check in the Windows check box and click OK, the current configuration of 
Excel windows will be preserved for each time you open the workbook. You can apply either Structure or 
Windows protection to a workbook, or you can select both checkboxes and protect both the windows and 
the structure of your workbook. 
 
You will notice that the dialogue contains an optional Password box. If you enter a password in this box 
and then click OK, Excel will ask you to confirm the password. 
 

 
 
If you re-enter the password correctly and click OK, only users who know the password will be able to 
remove the protection you applied.  
 
If you do not use a password, any user can remove the protection simply by clicking the Unprotect 
Workbook button on the Review Ribbon.  

 

 
 
This button will remove the workbook structure or windows protection that you applied.  
 
If you entered a password when you applied the protection, clicking on the Unprotect Workbook button 
will display the following Unprotect password box. 
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You must enter the correct password in the field provided and click OK to remove the protection. 

Protecting your Excel Files 
There is still another type of protection that you can apply to your Excel workbook that works on the file 
level. Basically, you can secure an Excel 2007 file so it cannot be opened without a password. Moreover, 
you can also protect an Excel file so that it cannot be modified without a password. 
 
To do this, open or create the Excel file that you want to protect, and then display the Office menu. 
 
When you see the Office menu, choose the Save as option to display the Save as dialogue box. 

 

 
 
In the Save As dialogue, click the Tools button in the lower left, and then select General Options from the 
pop up menu. 
 
This action will display the following dialogue. 
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If you enter a password in the Password to Open field and then click OK, Excel will then open a confirm 
dialogue box where you to type the password again to confirm it. When you click the OK button on the 
confirm dialogue box, the file becomes password protected. This means that when you try to open the 
file, you will be prompted for the password, which you must enter correctly to proceed. 
 
You can also specify a password in the Password to Modify text field. The process is exactly similar to the 
method just described for the Password to Open. 
 
If you set a password to open the workbook, you will see the following box displayed after you save and 
then reopen the workbook. 
 

 
 
You must know the password to open this workbook. If you do know it, you can proceed to open the 
workbook. 
 
If you set a password to modify the workbook, you will see the following box after you save and reopen 
the workbook. 

 
 
Here the person opening the workbook has the option of clicking the read only button to open the 
workbook. The user will be able to view and modify the open workbook, but when they try to save it, they 
will not be allowed to save the modified version over the original. Excel will enforce the use of a different 
file name, and protect the original workbook from being modified. 
 
You can open the workbook with full privileges only if you use the password.  
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Unit 6 Practice Activity 
 
1. Open the file Sales analysis.xls. 

2. Locate the cell showing a formula error in the spreadsheet. 

3. To trace the error:  

� Select the cell showing the error. 

� Go to the Formulas tab, Formula Auditing group, click the Error Checking button followed by 
Trace Error.  

� The arrows show which values are used to make the calculation in the cell you have selected. 

 
4. Using the arrows showing on screen to assist you, determine what is causing the error in the formula 

and edit the spreadsheet to resolve the error. 

5. Insert a comment displaying the text ‘Error fixed’ in the cell previously showing the error. 

6. Protect the sheet with a password. 

7. Save the file as My Sales analysis and close. 

 
 

Online support forum and knowledge base 
www.microsofttraining.net/forum.php 
Visit our forum to have your questions answered by our Microsoft certified trainers. 
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Unit 7: Using Templates 
This unit focuses on helping to understand how to use inbuilt templates, and modify and create custom 
templates. 
 
By the end of this unit, you will be able to: 

� Access and use Excel’s in-built templates  
� Create, modify and use custom templates 

 
A template is a workbook design or layout that can be saved and reused for any number of workbooks. A 
template can have formulas, fill effects, labels, borders, worksheet names, formats, and a host of other 
Excel features that will be applied to each new workbook that uses the template. 
 
This is an example of an Excel template. 
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Opening a Template 
To open a workbook using a template, start Excel 2007, and then choose the New option from the Office 
menu. When you do this, you will display the New Workbook Dialogue. 
 

 
 
In the New Workbook dialogue, you can select a template grouping from the categories listed in the panel 
on the left. When you click on a category option, the large viewing pane will display the templates 
available in the chosen category. If you double click on a template icon in the main viewing area, a 
workbook will open based on the selected template. 
 
If you click the My Templates option, you will display a New dialogue box that contains templates stored 
locally on your computer. 
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If you double click one of the template icons in the My Templates view, a workbook will open based on 
the template. 
 
If you click the New from Existing option in the New Workbook dialogue, you will display a New from 
Existing workbook dialogue. 
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The New from Existing Workbook dialogue has the same controls as the Open dialogue and the Save as 
dialogue. Basically, this dialogue box will allow you to navigate to a location on your computer and use an 
existing template (or an existing workbook) to base your new workbook on. Once you find an appropriate 
source for your new workbook, double click the icon in the viewing pane to open it. 

Downloading a Template 
When you display the New Workbook window (by clicking the New option under the Office menu) you will 
see a variety of options listed under the From Microsoft Office Online heading in the panel on the left. 
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You can choose from business templates, calendars, finance and accounting templates, specialty papers, 
and more. When you select one of these online options, you will often see a list of template subcategories 
in the viewing pane on the right.  
 
This list of subcategories is actually downloaded from the Microsoft Office Online Web site. If you do not 
have an Internet connection, you will not see the list of subcategories and moreover, you will not be able 
to download any templates. 
 
If you do have an Internet connection, you can click on one of the subcategory options to see a preview 
list of downloadable templates.  
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The image that follows shows some of the downloadable templates under the Budget subcategory. 
 

 
 
When you see a template that you like, select it by single clicking on it, and then click the Download 
button to download the template. Once the template is downloaded, Excel will automatically open a 
workbook based on the template. You can also simply double click on the template icon to download the 
template and create a workbook.  

Using a Template 
Probably the easiest thing you can do with an Excel template is use it. That is the reason why templates 
exist in the first place: to make it easy to build nicely formatted spreadsheets and workbooks. To use a 
template, start Excel 2007 and use the New window to open a workbook based on the template of your 
choice. (Refer to the preceding concepts in this lesson.)  
 
Once the workbook is open, the formatting and organization of your data will all be in place based on the 
template. The next step is to just enter the data into the spreadsheet as required. 
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Here is a sports template after some data has been entered. 
 

 
 
The whole purpose of the template is to provide a boiler plate format, organization, and style for your 
workbooks. All that you have to do is enter the data as required. When you save your work, make sure 
that you save it as a workbook. By doing this, you can create any number of workbooks based on the 
same template. 

Creating a Template 
To create your own template, open Excel 2007and design your worksheet or workbook layout to meet 
any specifications you require. You can add labels, formatting, colour, borders, and formulas. If need be, 
you can even create layouts on different sheets in the workbook, as a template can contain as many 
worksheets as you need. 
 
Remember, the main purpose of a template is for repeated use of a workbook layout. Keep this in mind 
when creating a template. Plan your layout, labels, and formats to make your templates comprehensive 
and complete. 
 
When you have completed your design, choose Save As from the Office menu to display the Save As 
dialogue box. In the dialogue, enter a name for your template in the File Name text field. Next, display the 
Save As Type drop list near the bottom of the dialogue box and select the Excel template option. (You 
may have to scroll through the list of options to find it). This will save the file as filename.xltx. When you 
choose the Excel Template option from the Save As Type drop list, the Save In text field will automatically 
be filled in with the word Templates. 
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This means that your new template will be automatically saved in the Excel Templates folder. (You can 
choose another folder to save your templates in if you wish, but if you do, they will not be available when 
you click the My Templates option in the New Workbook window). 
 
Once you save the file as a template in the Templates folder, it will be available under the My Templates 
option in the New window. If you intend to use the template with earlier versions of Excel, save it under 
the Excel 97-2003 Template option for backwards compatibility. If you have a macro or macros in your 
template, save it under the Excel Macro-Enabled Template option. 
 
Rather than create a template from scratch, you can always download a template that is close to what 
you are looking for and modify it in Excel to make it suit your needs exactly. After you finish customizing 
the template; save it with a new name in your templates folder as described above. Simply remember to 
save it as a template rather than a workbook. 
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